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Ingenuity Pathways Analysis (IPA)

Using the Ingenuity Knowledgebase understand 
genes and disease
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Some Questions IPA Can Answer

September 13, 2007

 What does my gene/protein/compound of interest do? 

 What  other compounds bind my target of interest?

 If I inhibit or activate a target protein, what cellular processes are likely to be affected that 

are beneficial or lead to adverse side effects?

 What are the upstream activators or downstream targets of my protein of interest?

 What can my microarray data tell me about changes in cellular functions, pathways, and 

toxicology?

 What genes are implicated in my disease of interest?

 What proteins might act as good biomarkers for drug efficacy?
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Basic gene and chemical search

Finding curated information about a gene/gene-product or drug, reagent or 
biochemical
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Search Basics

Enter a gene or protein name in the search box

Enter a drug or chemical name in the search box
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Search Basics, Continued

More than one search term can be entered at once

 Comma delimited

 Copy a column of IDs from MS Excel and past directly into the search box

Search terms can be any IPA supported identifier.

 Genbank, SwissProt, Affy probe ID, RefSeq, etc.

 See Help Manuel, “Data Upload Definitions” for complete list

Wildcard symbol should be used with searching with a partial gene name

 When searching or expecting protein isoforms or related IDs, append a wildcard “*”

 Example:  “SERPINE*”  will find all gene and protein names that begin with SERPINE
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List Result

Search results return as a list of entities that have a name or synonym that closely matches the 
search term

The search term “SERPINE1”

Single-click the name to 

follow the link to the 

corresponding Gene View
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Gene View Page

Species specific information

Summary tab, partial view

Name and physical characteristics from 

public domain

Links to IPA Canonical Pathways

Summary of Ingenuity curated 

findings

Gene Ontology information 

from public domain

Link to full content

Drug Information

Recently Added Findings

Description

Reagent View
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Curated Literature Findings

Reference can be viewed by clicking the 

plus-sign, or “Expand All”.

Pubmed ID links to abstract.

Header Links for navigation to point of 

interest.
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The Ingenuity Knowledge Base

The Ingenuity Ontology

Ingenuity Findings
Ingenuity® Expert Findings – Manually 

curated Findings that are reviewed, from the 

full-text, rich with contextual details, and are 

derived from top journals.

Ingenuity® ExpertAssist Findings –

Automated text Findings that  are reviewed, 

from abstracts, timely, and cover a broad 

range of publications.

Ingenuity Modeled Knowledge
Ingenuity® Expert Knowledge – Content 

we model such as pathways, toxicity lists, 

etc. 

Ingenuity® Supported Third Party 

Information – Content areas include 

Protein-Protein, miRNA, biomarker, clinical 

trial information, and others

The Ingenuity® Knowledge Base
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• Synonyms, Protein Family, Domains
GO, Entrez Gene, Pfam

• Tissue and Biofluid Expression & Location
GNF, Plasma Proteome

• Molecular Interactions
BIND, DIP, MIPS, IntAct, Biogrid, MINT, Cognia, etc.

• miRNA/mRNA target databases
TarBase, Argonaut 2

• Gene to Disease Associations
OMIM, GWAS databases

• Exploratory Clinical Biomarkers

• Clinical Trial information
clinical trials.gov

Ingenuity® Supported Third Party Information
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Search Basics

• Enter a drug or chemical name in the search box
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Chem View Page

Summary tab, partial view

Name and physical characteristics 

from public domain

Links to IPA Canonical 

Pathways, if available

Link to full content

Summary of Ingenuity 

curated findings
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Chem View Continued

If the chemical is a drug, there will be additional information such as manufacturer, 
clinical trail status, target(s), and action
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Summary

 IPA Search retrieves a wealth of experimental evidence for genes and proteins on the Gene 

View page, and Drug and Chemicals on the Chem View page.

 Gene and Chem pages display information that is explicitly known about a gene or 

molecule; there is no inferred or hypothetical information (this is done through custom 

pathway building).

 Gene and Chem View information is based primarily on literature findings taken from the 

full-text of journal articles but may come from other defined sources with references.
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Function & Disease to Gene search

Finding gene and chemical entities associated with biological functions, 
processes, and diseases
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Function/Disease Search and Results

One can also find molecules (gene/chemicals) associated with a biological process or disease. 
Results are listed in a tree or list format.
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Limit Search to Exclude Chemical Entities using Advanced Search
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Effect on Function and Findings

Clicking the function text to see the effect-on-function and then clicking to view findings works well there are a 
small number of results.
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Gene/Chemical Names Link to View Pages

Click plus-sign to expand selection

Gene names lead to Gene View pages
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Function and Disease Results

What now?

• Send to a pathway to connect to other genes or overlay 

biological criteria to subset

• Save as list.  

• A list can be 

• Used to limit Grow (create pathway to these genes)

• Used for Overlay (visualize intersections)

• Compared to other lists (File->New->Compare)

• Sent to a Core Analysis

• Further analyzed in BioProfiler to subset
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Advanced Analytics
Causal Networks

BioProfiler

Advanced Analytics requires an additional subscription fee
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Questions BioProfiler Can Answer

 Which genes when [increased] in activity [increase] [COPD]?

 Which genes when [decreased] in activity [increase] [liver cholestasis]?  What 

types of [genetic] evidence support this?

 Which genes are potential [diagnosis OR prognosis] biomarkers of [breast 

cancer] and are [upregulated] in breast cancer?

 Which genes are known to both [affect OR increase] [colorectal cancer AND 

obesity]?
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Questions BioProfiler Can Answer

Targets of toxicity: 

 Which genes when [decreased] in activity [increase] [liver cholestasis]?  What 

types of [genetic] evidence support this?

Target discovery: 

 What [heterozygous knockouts] in [mouse] can [decrease] [asthma]?

 Which drugs or which targets have been in late stage clinical trials or approved 

to decrease [diabetes]?

Biomarker research: 

 Which genes are potential [diagnosis OR prognosis] biomarkers of [breast 

cancer] and are [upregulated] in breast cancer?
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BioProfiler enables precise filtering on the “components” of Ingenuity 
Findings

genezygosity effect on disease

species evidence mutation type

disease

Activity of the molecule 

in this finding 

(decreased)

Infer
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BioProfiler: quickly profile a disease, phenotype, or function

Identify genes known to be causally relevant as potential targets or identify 

targets of toxicity, associated known drugs, biomarkers and pathways

• Filter down to genes known to be 

causally associated with Alzheimer’s

• Which genes when decreased in 

activity increase liver cholestasis?

• What types of genetic evidence 

support this?
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• Find molecules causally relevant to the disease or phenotype

• Filter by specific genetic evidence or species

• Explore association with other similar diseases or 

phenotypes/symptoms leveraging the depth of the Ingenuity 

Ontology and the Human Phenotype Ontology 

BioProfiler: Find, Filter and Explore 
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Find genes or chemicals that might be therapeutic for lung fibrosis 
(BioProfiler)

Drug targets: genes or proteins that when decreased in activity, decrease lung fibrosis
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BioProfile Example

Alzheimer’s Disease 
Identify and understand key molecules involved with the disease for potential target discovery
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BioProfiler:  Very simply search….and filter

Proprietary and Confidential 29
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Show me only those molecules that when increased are known to 
increase Alzheimer's disease.

Proprietary and Confidential 30

Quickly identify 9 molecules causally relevant to Alzheimer’s from 682 search 
results

Increased activity in APP increases Alzheimer’s disease
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Filterable finding level attributes

Molecule Activity

 Whether the finding indicates increased or decreased activity

 Calculated using various factors

 Observed upregulation or downregulation

 Functional effect of mutations

 Etc.

Effect on Disease/Function

 Whether the disease or function was increased or suppressed

Species evidence and Tissue/Cell line

 Select specific species e.g. mouse, and/or specific tissues e.g. lung

Mutation evidence

 Limit to certain mutation types e.g. homozygous, knockout

Causal v/s correlation
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Find known drugs associated with key causally relevant molecules

Select molecules, place on a pathway and overlay drugs
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BioProfile Example

Proprietary and Confidential 33

Analysis of the clinical aspect of EMT in Breast Cancer

Exploring the EMT molecules involved in breast cancer.

– Focusing on the Upstream Regulators predicted to be activated in the dataset to 

explore which ones if any would be of interest for therapeutic purposes.

Do any of these molecules of interest have biomarker application in breast cancer ? 
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Mesenchymal / stem cell-like breast cancerLuminal Breast cancer Basal HER2-enriched

Ratio Claudin-low to Luminal
5 vs 5 cell lines, RNA-Seq data

Luminal cell lines Claudin-low cell lines

Epithelial to Mesenchymal Transition
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All answers with BioProfiler! 

Proprietary and Confidential 35
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1432 Molecules related with findings to Breast Cancer

Proprietary and Confidential 36
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1432 Molecules related with findings to Breast Cancer

Proprietary and Confidential 37
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Narrowing down to Genes, RNAs and Proteins common to Breast 
Cancer and EMT: 47 molecules

Proprietary and Confidential 38
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EMT-Breast Cancer molecules: Filter down further on molecules testable 
for therapeutic purposes: with interest in specific criteria and combining 
with previous Upstream Regulators Analysis: 17 molecules

Proprietary and Confidential 39

1 2 3 4
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Upstream Regulator Analysis indicated the predicted activated 
regulators in the dataset: 114 UR (Z-score > 2)

Proprietary and Confidential 40

Click ADD TO MY LIST
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Comparison of the 2 lists using File>New>Compare

Proprietary and Confidential 41
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Analysis of the clinical aspects of Breast Cancer (EMT focused) 

Proprietary and Confidential 42

Exploring the EMT molecules involved in breast cancer.

– Focusing on the Upstream Regulators predicted to be activated in the 

dataset to explore which ones if any would be of interest for therapeutic 

purposes. 2: EGFR, TGFB1

Do any of these molecules of interest have biomarker application in breast cancer ? 

– EGFR: diagnosis

– TGFB1: disease progression
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Is there biomarker application of EGFR or TGFB1? 

Proprietary and Confidential 43
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Ingenuity pathway search
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Ingenuity Pathway Search

Most common workflow will be to open pathway after search
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Understanding Canonical Pathways
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IPA Canonical Pathways

 Canonical pathways are constructed, curated, IPA pathway diagrams for well established 

signaling and metabolic pathways

 Vary in size

 May contain one or more pathway branches or paths

– Shows the canonical pathway in a large context

 Canonical Pathways can be modified and saved

 Genes and molecules can be added or removed

 Can be converted to Path Designer

 Canonical pathways show you both key biological and molecular roles of proteins and 

chemicals of interest. 
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From the Gene View Page
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Protein of interest is highlighted.

Pathway Report
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Pathway Reports

HTML and PDF formats

Reports contain

 Description

 Top functions

 Molecule list

 Drug Summary

 Target Information

 Link to references
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Pathway Navigation

Scroll-wheel on mouse controls zoom, or use toolbar zoom buttons.

Left-click selects (turns blue) 

Left-click-drag on nodes moves the node

Right-click hold-and-drag moves your view

Right-click brings up menu for controlling

 tool tip (mouse-over node pop-up)

 copy/past

 Highlight

 selection

Node shapes indicate a protein’s primary function, see Help>Legend

Relationship lines indicate the type of relationship and the mouse-over letter the type of 
relationship, see Help>Legend

Navigation Control
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Pathway Navigation, continued

Double-clicking a node brings up the node summary

 You can navigate to the Gene/Chem View page by clicking the protein name at the top of 

the summary window pane.

Double-clicking a relationship line brings up the relationship summary

 You can to the literature evidence findings by clicking the “View relationships between:…” 

link at the top of the summary window pane. 

Groups

 Groups are represented by a double outline applicable to any molecule shape.  These 

represent cases where findings use a general gene name to describe a gene class or group 

of isoforms

 Complexes of different proteins are also given a double outline

 View members by left-click selecting, then right-click>Show Membership
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Building Custom pathways



Sample to Insight

Some Questions That Can Be Answered by Creating Custom Pathways

 What  other compounds bind my target of interest?

 If I inhibit (LOF) or activate (GOF) a protein (gene), what cellular processes are likely to be 

affected and how will they change?

 What are the upstream activators or downstream targets of my protein of interest?

 Might there be adverse effects of a drug

 Explain how a loss-of-function mutation results in a disease phenotype

 What proteins might act as good biomarkers for molecular drug effect?
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How to Implement the Build Tools

1. Select nodes that you want to operate on

2. Click the BUILD button to open the build toolbox

 Not necessary if the build window pane is already open

3. Choose a build tool in the pull-down

4. Set tool parameters and filters

 Highly recommended to use filters

5. APPLY
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Build Tools

 Grow: Adds new molecules and their relationships given the criteria that the user specifies

 Disease & Functions: Adds nodes representing diseases or biological 

function/processes based on gene enrichment of pathway genes

 Path Explorer: Calculates the “Shortest Path” between 2 molecules or 2 sets of molecules

 Connect: Connects molecules given the criteria that the user specifies

 Trim: Removes molecules/relationships that meet the criteria that the user specifies

 Keep: Keeps molecules/relationships that meet the criteria that the user specifies

 Add Molecule/Relationship: Add a custom molecules or relationship to the current 

pathway that does not exist in Ingenuity’s Knowledge Base as well as ones that already 

exist
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How Grow Works

 Adds new molecules and their relationships given the criteria that the user specifies

 Recommend growing to “All molecules” and using relationship, molecule type, or other 

filters to limit grow

 If specifying “Add max of ‘x’ molecules”:

 Priority is given to those molecules that have a high degree of connectivity

– Prefers to add molecules that interact with the many molecules on the pathway 

instead of molecules not on the pathway

 De-emphasis on “hub” molecules that interact promiscuously with many molecules that 

are not on the pathway
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Tips on Using the Grow Tool

•Genes (proteins, chemicals) will not be added if already present somewhere on the pathway.  

– Know if the molecule you are growing from already connects to others in the pathway using 

Connect or Path Explore

•Newly grown out nodes do not automatically CONNECT to other nodes in a pathway.

– Use Connect or Path Explorer after Grow to see these relationships.

•Protein-Protein (PP) relationships and other binding relationships will be added when growing 
either upstream, downstream, or both directions. 

• Recommend as a separate Grow step.

•If Grow is used directionally, only the specific directional interactions (edges) will be displayed.

– Select new nodes following Grow and use the connect tool to add all interactions from the 

Knowledge Base.
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Search and Add to Pathway
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Grow Downstream

Select gene you want to grow 

from.

In “Relationship Types”, deselect binding 

relationships: 

chemical-protein interactions

protein-protein interactions

protein-RNA interactions
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• Click in white-space to deselect

• Right-click to “Reset Highlight”
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Investigate Relationships
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View Literature Findings

Click to view citation
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GROW to Disease & Functions

Title, Location, Date 64

• Drag disease node to left from center
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Model Gene Effect on Disease Using MAP

Title, Location, Date 65
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Overlay Tools

 Analysis/ Dataset: Expression/data values that have been uploaded into IPA

 Drug: Known drugs that target the molecules on pathway

 Function & Disease: Functions and Diseases that overlap

 My List/My pathway: User created lists/pathways saved within IPA that overlap

 Canonical Pathway: Canonical Pathways that overlap

 Biomarkers:  Displays the molecules that are known biomarkers for specific Applications 

and Diseases

 Ingenuity Tox List: Ingenuity created toxicity related lists that overlap

 Highlight: Outline molecules that match specified criteria
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Find Existing Drug Targets

Use the drug overlay tool to identify drugs that target proteins on the pathway.

Labels provide links to Chem Views

Highlight Mode at bottom of Overlay pane provides easy visualization of drug targets

Drug summary provides indications and clinical status of drugs that target the pathway



Sample to Insight



Sample to Insight



Sample to Insight



Sample to Insight

Saving a Pathway

Once a pathway is complete, make sure to save it

1. Using the save icon in the tool bar      if you are saving a new one

2. Using File>Save or File>Save As… if you edit an existing one

2

1
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Send to Path Designer for Image Editing
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Search and Explore Review

73
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How Path Explorer Works

Calculates the “Shortest Path” between 2 molecules or 2 sets of molecules

If 2 molecules/sets don’t have specific connections in IPA, Path Explorer will find how many and 
which molecules can be added to this pathway to create the shortest path

 Shortest Path (n)

 Shortest Path + 1 (n+1)

 Shortest Path + 2 (n+2)

A n

n+1

n+2

B
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General Pathway Navigation

Introduction to QIAGEN Ingenuity & IPA - www.ingenuity.com 75

Tool Bar in Pathway/Network view that contains a variety of functions

 Save: Save molecules in the pathway as a graphic or as a list

 Edit: Delete, Copy, Paste, Undo, Redo, and Find

 Build: Grow, Path Explorer, Connect, Trim, Keep, and Add Molecules/Relationships

 Overlay: Analyzed Dataset, Molecule Activity Predictor, Drugs, Function & Disease, My 

List, Canonical Pathway, My Pathway, Ingenuity Tox List, and Highlight

 Path Designer: Make a publish/presentation quality version

 View: Auto Layout, Sub Cellular Layout, View Annotations, and Preference Settings

 Zoom: Overview, Zoom In, Zoom Out, Zoom Selected, Fit to Window, and Magnifying 

Lens

 Export: Image, Data, e-Mail, and Print
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Build Tools

Introduction to QIAGEN Ingenuity & IPA - www.ingenuity.com 76

Grow: Adds new molecules and their relationships given the criteria that 
the user specifies

Path Explorer: Calculates the “Shortest Path” between 2 molecules or 2 
sets of molecules

Connect: Connects molecules given the criteria that the user specifies

Trim: Removes molecules/relationships that meet the criteria that the user 
specifies

Keep: Keeps molecules/relationships that meet the criteria that the user 
specifies

Add Molecule/Relationship: Allows adding a custom molecules or 
relationship to the current pathway that does not exist in Ingenuity’s KB as 
well as ones that already exist
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Overlay Tools

77

Analysis/ Dataset: Expression/data values that have been uploaded into 
IPA

Molecule Activity Predictor (MAP): Uses expression or user-defined 
activation states to predict the activity of neighboring molecules

Drug: Known drugs that target the molecules on pathway

Function & Disease: Functions and Diseases that overlap

My List/My Pathway: User created lists/pathways saved within IPA that 
overlap

Canonical Pathway: Canonical Pathways that overlap

Biomarkers: Displays the molecules that are known biomarkers for 
specific Applications and Diseases

Ingenuity Tox List: Ingenuity created toxicity related lists that overlap

Highlight: Outline molecules that match specified criteria


